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3P Desktop Publisher

The 3P Desktop Publisher is a downloadable editing application.
The 3P Desktop Publisher can be freely distributed to consumers

Consumers then create their photo products with the editor and upload it
to the 3P shop for ordering.

The editor provides product templates based on a product description
from the file products.xml, which is part of the client data package and
product templates and layouts also part of the client data package.

For the shop owner the editor serves a second purpose of usage as an
editor for the forementioned layouts and templates.

Please note that all screens shown in this chapter have been captured
from a Editor with a Kodak specific branding (Kodak Demo Editor). The
editor can be extensively branded, i.e. the look&feel may be different on
your editor.

Editor Installation
The editor is installed from an executable. This executable is created by
the shop owner using the Setup Wizard. As the editor itself, the setup
executable can be branded. The screenshots for demonstration show a
Kodak branding.

The setup executable may come from any source, e.g. download or CD
and may have any name.

After startup it will show a welcome screen.

1
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Click Next on the welcome screen to start the installation process.1

2

3

Accept the license agreement then click Next to continue.2 3

4

5

Enter a valid installation directory (use the Browse button if required),4
then click Next to continue.5

The installation directory defaults to the program files directory plus the
name of the editor, unless an editor with the same branding is already
installed. in this case it defaults to the last installation directory of that
editor.
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6

There are no options on the following screen, so click Next6 to continue.

7

8

Enter a menue where the shortcuts in the Start Menu - Programs will be
placed . This also defaults to either the name of the editor, or if already7
installed, to the last installation point.

Click Next to continue..8
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9

10

Select if you would like to create an icon on the desktop or an icon in the
quick-launch bar . Click Next to start the installation process.9 10

After the installation, the setup executable presents an option to start the
editor .11

11

12

Click Finish to close the setup program.12
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Using the Editor
The usage of the editor is quite intuitive. Therefore this chapter will not
focus on every single button, but instead provide a quick overview of
editor functionality and more detailed information on how to configure or
customize certain aspects.

Product Wizard

When started, the 3P Publisher will come up with a product wizard, allow-
ing a consumer to easily select a product he would like to build.

The initial page shows a customizable welcome page which may also be
used as a platform for marketing messages . This page represents the1
file wzWelcome.htm in the client data package.

It provides an option to configure settings2 , to open an existing project
3 or to start with a new project 4 .

1

2 3 4

Closing the Wizard at any time will also close the 3P Desktop Publisher!

Settings 2

The settings button will display a settings dialog allowing to configure
network proxy settings or to manually trigger an update of the client data
package.

This will allow you to configure the editor to use a proxy server for com-
munication with the shop. This typically is only required in more sophisti-
cated network environments like company networks. Nevertheless it may
be required for certain home user configurations, too.
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In the dialog you may enter a proxy configuration or click Update5
Products to manually trigger an online update of the client data pack-6
age.

5

6

Open Project 3

The open project button allows to open an existing project. This is basic
File-Open functionality. The filename extension of the file to open should
be .dtp.

You will receive an error message when trying to open a dtp file which has
been created by an editor with different branding or when trying to open a
file which has been created in design mode (see later sections).

New Project 4

Clicking on New Project will guide the consumer  through the product
selection process .

7

8
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In a first step the wizard will present a list of available products for7
selection.

For every product there is a detailed description whenever the prod-8
uct is selected.

The product list is generated based on the available products in the7
products.xml file which is part of the client data package. The description
page is also based on information from the products.xml file,8
formatted according to the wzProduct.htm file from the client data
package.

The next page presents a list of features and options for the selected
product. This page is optional, i.e. the wizard skips the page when there
are no features and options defined.

The list is based on the features/options information in the products.
xml file.

9

10

Features are represented by radio buttons, options for the feature - if9
any - are represented by a dropdown box as soon as the user clicks on

10it.

There is no limit to the amount of features and options for a product,
nevertheless the user interface may appear cluttered if too many features
and options are specified in products.xml.
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On the next page the user can see an overview of the product and options
selected. Please note that there is always a Previous button to change
selections.

The page displays data according to the information the user has selected,
formatted according to the wzSummary.htm file (Client Data Package).

The next page allows a user to select if he’d like to start with an empty
book, or if the book should be filled with templates and images.

11

12

13
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Create a new empty project 11

Selecting this option will start with a completely empty book, i.e. the book
will consist of the layout file only. No templates will be applied to the
pages. An exception is when the layout file already does contain assigned
templates or has predefined images etc.

Create a new empty project from page templates 12

Selecting this option will create a new file as mentioned for the previous
option. In addition it will present a dialog, allowing the user to select page
templates - basically the pages of the template file - to fill the book with.

The template pages may or may not contain images, nevertheless no
consumer images will be placed.

The consumer can select one or multiple templates from the template list

16

17
18

14 19

15

. Those templates will be assigned to all pages of the product.14

If the Apply in random order checkbox is checked, the order in15
which the templates are assigned is random, otherwise the templates will
be assigned in the order they are listed in. The sequence will be repeated
until all pages are filled.

The Page Color button allows to pick a color for the page background16
for all pages.

The Font button selects the font used for text fields in case the tem-12
plates do contain text boxes.

Add Shadow or AddFrame will add a shadow/frame to all image18 19
boxes in the templates selected.
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Autofill new project from selected images 13

This function is similiar to the previous option Create a new empty
project from page templates. In addition to filling the layout
pages with templates, this function will also fill the image placeholders in
the templates with consumer-selected images.

This option therefore will result in a - in most cases - completed book.
Nevertheless the consumer will still be able to correct the auto-filled
product after completion of this proces.

In order to allow the consumer to select the images to be filled in,  the
editor presents a selection dialog before showing the template selection
dialog.

23 24 25 26

22

27

21

20

The autofill dialog  holds a thumbnail view of the images selected for auto-
fill 20 , a preview pane21 and a image data pane22 for reference.

The thumbnail view will be initially empty, you can add images to the
thumbnail page by

• clicking the Add Images23 button which will display a file selection
dialog (multi-select)

• clicking the Add Folder button which will display a directory selec-24
tion dialog. Selecting a directory will add all valid images in that direc-
tory to the view.

• drag and dropping image files, e.g. from Windows Explorer directly to
the thumbnail view.

Delete images by clicking the delete button. Deleting images will only25
delete them from the view, the stored files will not be touched.

The images will be filled into the book in the order they are shown in the
thumbnail view.
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You can change the order by

• manually dragging images to a different place in the view.

• using the sort buttons to sort images alphabetically or by date.26

If images are misoriented (e.g. updside down) you may rotate single
images using the context menu of the image. To access the rotation27
menu either right-click the image or click on the arrow button in the right
lower corner of the selected image.

For image selection (e.g. to delete or move images) the thumbnail view
behaves according to Windows standard, i.e. use  Shift-Click to select a
range, Ctrl-Click to select multiple items, or Shift & Ctrl in combination
with the arrow buttons to select without mouse.

When clicking OK the Editor will continue with template selection as
explained in the section Create a new empty project from
page templates above.

As opposed to the Create from Templates function, the Autofill function
will only fill pages with templates when there is at least one image to be
filled into the template.
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Editor Compact Tutorial

After completion of the product wizard, respectively after loading a new
file, the editor will come up with the main interface.

The editor holds the standard Windows menu and toolbar. The working
area is structured into

• an image area on the left1 allowing a user to select and pick images
for his book.

• a thumbnail preview area on the top, for a quick page preview and2
to select the working page

• a templates and properties area3 on the right for picking page
templaes or to change properties of selected elements

• the working desktop with a WYSIWYG representation of the4
current page or spread.

2

5

1
3

4 6

5
5

The areas are separated by sliders which can be dragged to change the5
size of the corresponding areas. Clicking on the buttons on the slider6
will close the corresponding area or reopen it, if closed.

This way it is possible to enlarge e.g. the desktop at the expense of e.g. the
template area.



1STEIN Corp. - 3P Desktop Publisher - Documentation Page 13

7

6

Please note that the amount fof functionality available is depending on the
state of the Expert Mode 7 button. (This button may be configured to be
unavailable !)

Basic operation of the editor starts with optionally dragging a template
from the template page to the working page. This will leave some empty
image frames and text frames on the page:
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Now drag thumbnails from the images area to the empty image frames.

You can also skip the template step and drag images directly to the empty
page!

Click on one of the image frames to select it, the right side of the screen
will then automatically switch from Templates to Properties.

Unless configured otherwise you can move the images and text on the
page around. Change the size by using the round white handles on the
image . The green handle on the top is for rotating the image.1 2

2
1

Select the properties you would like to apply, e.g. a shadow . Note that3
some properties do open an own settings dialog where you can fine-4
tune it, e.g. change the color of the shadow.

Click on the property’s button again to remove the effect.

3

4
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Now right-click an image thumbnail in the image are or click on the arrow
button in the lower right corner to open the context menu of the image.

Select Set as Background Image .5

7

8

9
11

5 12
10

6

Alternatively you can drop the image on the outer region, close to the
border of the page. While dragging the whole page will get a black border
when you are on the position for dropping a background image.

On the background dialog you can select a transparency for the image6
- typically used to fade background images a bit.

For a 2-page spread you can also select if you would like to apply the
background to the left/right page or to the entire spread .7

Selecting Apply to all pages will apply the same background settings to8
the whole book. Be aware that this might overwrite background settings
you already made for other pages of the book!

With Background Color you can select a color for the page. The trans-9
parency setting will fade the image to that color. You can select a color
only by either setting the image to 100% transparent or by clearing the
image.

You can also load an other image from the dialog or do expert editing10

on the image .11

When finished click OK and the editor will apply the background to the
page. If you selected to add the background to all pages, the process may
take a while.

Now double-click a text box on the page.

If the template you selected does not contain a text box, you can open a
text box by clicking the Add Text button in the toolbar or using the menu
Shape - Add Text. After dragging a rectangle, click the created tex box.

Empty text boxes hold a text “Double-click to add text” to better illustrate
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the location of the box. If you do not change that text, the box will be
printed empty (i.e. this text will not be printed).

Double-clicking a text box will bring up a separate text editor. This editor
is a very powerful tool, comparable to a word processor, i.e. it support
different fonts, tables, bullets etc.

Edit your text and close the dialog to see the change in the book.

You can also apply effects and properties like shadows, frames etc to1
text for a professional and individual design of your book.

5

1



1STEIN Corp. - 3P Desktop Publisher - Documentation Page 17

Now double-click an image or select an image and click the Edit Image
button.

This will bring up the image editing dialog with options to improve and
crop your image.

2

3
4

Use the options on the right as required. When cropping an image, you2
can uncheck the Keep Aspect Ratio option. In this case the aspect ratio of
your image frame will be adjusted to your cropping area, i.e. it may be
required to resize or reposition the frame after closing the dialog.

You can always use the View Original button (click & hold) to see3
the difference between the original and the modified image. The Revert

button will undo all changes. Please note that the changes can not be4
undone after clicking the OK button.

The editor will not change your original disk file, so in case of accidentially
clicking OK, drag the image on the frame again, which will reload the
original file from the disk.

Be careful about using the Enhance Image functionality. This is intended
for expert use only.

Continue editing your page until you are satisfied with the design. This
short manual is not intended to give a full description of all features of the
3P Desktop Publisher but should help to explore the functionality on your own.

When finished with the page or spread, click on the next page in the
thumbnail area to proceed.

When finished with the book, it is recommended that you use the preview
button to get a preview of the printed book. In preview you will see a5

preview of the book as printed, i.e. empty text boxed will not contain any
illustrational text, images exceeding page boundaries will be clipped etc.
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In preview mode it is still possible to do corrections to the pages, i.e. you
can move and edit images. Certain aspects may be less comfortable
though.

6
5

Navigate through the pages using the arrow buttons left and right of the
preview button . Click the preview button again to get back to5 5
editing mode.

When everything looks good, click on the Order Product6 button to
upload your file and order.

Editor Ordering Process

After clicking the Order Product button the editor will verify the prod-6
uct and check for any layout problems.

Layout problems are reported in a list with three classes of problems

Information

A message telling the consumer about a possibly unwanted fact or behav-
iour, like ordering empty pages. The user should verify that the mentioned
problem is not an issue, then this can be ignored.

Warning

Informing the user about a possible problem, which may or may not be on
purpose. An example is an image which is clipped at the border of the
page. Since this may be intended (e.g. intentionally put an image over the
border) this message can also be ignored, but should not be disregarded
alltogether.
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Error

Indication of a condition which does not allow the editor to continue. This
condition must be fixed before ordering. Typical example is an empty
image frame. Empty image frames cover part of the page and would be
printed. Since this is resulting in a likely unusable product, this is resulting
in an error.

6

7

8

You can quickly get to the page with an issue by clicking the link on the
corresponding message7 (Click here to review page ...).

When no or only information and warning class messages exist, the
Close button will change to a Next button and you can continue.8 9

9
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Online Ordering

Online ordering is the normal ordering process and supported by most
configurations. If the Editor supports also offline ordering, a dialog is
displayed asking if the ordering shall be online or offline. If ordering online,
answer yes .1

1

If the editor is configured for online (or offline) mode only this dialog will
be skipped!

The editor will then display a reminder to go online. Confirm after making
sure that you are online.

The editor will now go online and ask you to log in or register. Click the
forgot password link if you already registered but forgot your pass-1
word.

Either log in with email and password or click Please Register to2 3
register. Remark: you cannot register twice with identical email!
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1

3 2

If logging in with a known email and password the system will upload
immediately and forward you to your online shopping basket. If clicking on
the registration button 3 you first need to submit your registration.

You need to scroll all the way down to save, the editor wil then start
uploading.
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During the upload you can always cancel by pressing the cancelbutton 1

left of the progress bar. Any errors will be displayed in the list. In case of
an interupted upload, you can either continue or retry right from the dialog
or alternatively start the upload again at a later time.

In case of an interupted upload the editor will - provided the book has not
been changed - continue the upload at the page where it was interupted.

1

When completed, the editor will redirect you to the shopping basket in an
external browser. If that redirect fails, there is also a link in the upload 2
dialog to the shopping basket.

2

If the time for upload exceeds the server-configured session expiration
time, you may be required to log in again.

The ordering process in the shop is explained in the Chapter Shop Product
Overview.
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Offline Ordering

Typically there is a specific editor for offline ordering, i.e. offline ordering is
the only ordering method for that editor.. If the Editor supports also online
ordering, a dialog is displayed asking if the ordering shall be online or
offline. If ordering offline, answer No .3

3

If the editor is configured for offline (or online) mode only this dialog will
be skipped!

The editor will then ask for order data to save with the order. The page for
entering the data is the  wzUserData.htm page from the client data pack-
age. I.e. this page can be customized, including which data fields are
mandatory.

Enter the data and click Process Order to continue.4

4
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The editor will process the pages and then ask if you would like to burn a
CD using the build-in burning application or if you would like to manually
transfer the data to a CD or Memory stick etc.

When doing a manual copy answer No. The editor will then open a folder
holding a directory which you should move or copy to a stick or CD. Make
sure to copy the whole folder.
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Make also sure that the filesystem used for transfer can hold the folder
(right click and select properties to see the size) .

The folder may be bigger than a CD can hold (600-700MB). It may even
be bigger than 2GB. In this case make sure using a filesystem that can
hold more than 2GB. E.g the FAT filesystem cannot!

When using the internal burning application, answer Yes on the question
above. A wizard will guide you through the CD creation process.

All you need to do is to insert a blank media, select the burning device an
click Next until done.
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The resulting media then needs to be brought to the store for ordering.

The ordering process in the store is explained in the chapter on processing
store orders in the shop.

Technical Background
Before covering product design, for a better understanding of the process-
es involved it may be helpful to get some technical background on the
organization of the 3P Desktop Publisher.

You will be able to work with the editor without this background, never-
theless it may help in optimizing your workflow or in trouble-shooting.

When the setup for a branded editor is created, setup wizard assigns the
user-specified name to that editor. After installation this editor therefore is
known to Windows with this name.

The installer creates a set of files and directories, based on this name.

• the default installation folder, typically C:\Program
Files\<Name>

C:\Documents and Set-the client data pack folder , e.g. XP:
tings\All Users\Application Data\<Name> or Vista: C:\
ProgramData\<Name>

• a user specific settings folder, holding log files and settings: e.g. XP:
C:\Documents and Settings\<Username>\Application
Data\<Name>, Vista: C:\Users\<Username>\AppData\
Roaming\<Name>

The foldernames here are listed for English operating systems with default
settings. There may be differences with languages or special partitionings
etc.

The installer also assigns the file extension .dtp to the installed editor. (i.e.
when multiple editors are installed, the operating system will always try to
open all dtp files with the latest installed editor.

The installation directory for every installed brand of editor holds the
same files.

•
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CCPublisher.exe is the Editor executable

CCPublisher.dat is a INI-style file, holding some main global configurations
of the editor

templates.dtp is the template file for user templates, i.e. the templates a
user can save.

The other files are helper files.

The About directory holds the html and image files shown in the About
box of the editor.

CCPublisher.dat

The CCPublisher.dat file defines how the editor operates.

A typical contents is

[Setup]
SubShopID=kodak
SubShopName=kodak
Release=EN_25
AppName=Kodak Photobook Editor EN
AppTitle=Kodak Photobook Editor EN 2.5.11
AppUrl=http://www.kodak.com
AppUrlTitle=Support
AppVersion=2.5.11
AutoUpdateDays=0
SkinActive=1
OrderWorkflow=both
PDFPassword=weix2n-Arw7nYSEmnjHdaU

The SubshopID entry has to match the subshopid entry in products.xml.

The AppName is the name of the editor, when used in the Windows
Operating system. AppTitle is the name shown in the titlebar of the
application.

AppUrl is the URL the Help Support Entry refers to, AppUrlTitle is the help
entry text.

AutoUpdateDays is the amount of days between automatic updates (or 0
when an update is requested on every start.

SkinActive specifies if the skinning engine should be used

OrderWorkflow specifies if online, offline or both workflows are support-
ed.

PDFPassword is the encrypted Password for the ZIP file holding teh PDFs
for offline workflow.

As you might have noticed this is exactly what is specified for the setup
wizard. Nevertheless the entries can be changed manually - provided
required files are available - to change the editor settings (restart of the
editor required). So it is possible to e.g. for testing purposes modify an
editor to support offline workflow without rebuilding.
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Editor and Client Data Package

The editor holds a local copy of the client data package in the client data
package folder mentioned above. In difference to the client data package
on the server, the client also holds an unpacked version of the packed
client data pack files for performance reasons.

The client data pack is synchronized on a regular basis, latest when up-
loading, with the server files.

The editor uses files from the client data package in various ways. In
general all zip files are used for comparison to the server copy only. if
there is a difference the file will be downloaded and unpacked. from the on
only the unpacked files are used.

Products.xml is mainly used in the editor’s setup wizard for displaying
product related information and to select a product - there are some
exceptions, though

The htm files are for display purposes, mainly in the product wizard.

layout_*.dtp holds information about the layout of a product  and is re-
ferred from the corresponding product’s section in products.xml.

templates_*.dtp are holds information about the templates available for a
product  and is referred from the corresponding product’s section in
products.xml.

Files in the subfolders are helper files, referenced by products.xml or the
htm files, e.g. images, css and skin files.
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Templates & Layouts

The concept of layout, template and normal user files is somewhat hard to
understand.

All files are in dtp format and do have a dtp extension.

The concept is best explained when looking at the editor when started
with an empty book, i.e. no template fill, no autofill!

When started with an empty book and e.g. a product fb0001, the editor
will first look into products.xml and check for the names of the associated
template and layout file.

It will then essentially open the layout file and set the filename to1
Untitled to avoid overwriting. It will then open a read-only preview of2
the template file in the template area .3

2

1

3

The renamed layout file becomes the new user file.

Assigning a template to a page - simplified - is the copying of all objects of
a page from the template file to the user file. When saving, the user will be
prompted for a new file name. When he opens that file at a later point, the
original layout file is no longer involved, i.e. the editor will load the user
file, find the matching template file and load that into the template area.

For editing of both, layout and template files, the same software, teh
normal 3P Desktop Publisher is used. When opening a template file for editing in
the editor (design mode required!), the pages of the template file willbe
displayed in the normal thumbnail area , not in the template area !1 3
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Editor Design Mode
For editing template and layout files, i.e. for designing products, the editor
must be switched to design mode.

Design mode has two major functions.

• It enables editing and saving of layout and template files

• It enables an additional tab in the editor which allows to change
product design properties, like e.g. the locking of pages and frames.

Switching an Editor to Design Mode

The design mode functionality is built into every editor, nevertheless you
should use an already branded editor - build by setup wizard - to start
with. This way all subshop related configurations are already done.

So start with the installation of your branded editor.

Close the editor if running and locate the file CCPublisher.dat in the Edi-
tor’s installation directory.

Open the file using Windows Notepad and add an additional line
DesignMode=1 to the bottom of the file.1

1



1STEIN Corp. - 3P Desktop Publisher - Documentation Page 31

In order to switch the editor back to consumer mode, it is not required to
delete the line. Instead you can change it to DesignMode=0. This way it
is quite easy to switch back and forth between design mode and consum-
er mode.

After every change in CCPublisher.dat a restart of the editor is required.

In design mode the very first page of the product wizard shows an addi-
tional New Layout button.1

1

To create a new layout or template file, click the new layout button.1

You can also open an existing layout/template and modify it accordingly.

Please note that when creating a new product, this product must be
included in products.xml first. See the chapter on products.xml for an
explanation.
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1

Use the Design 1 tab to set up your new layout or template file.

Please note that editing the template or layout file direct from your local
copy of the client data package is not recommended. The files are typically
locked and cannot be overwritten (files are in use).

Therefore it is always recommended to edit the files in a specific working
directory, then if testing is required, close the editor, copy the files to the
local client data package directory (C:\Documents and Settings\All Users
...) and then restart the editor.

You can find a more detailed description of the Design tab below.1
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Setup a new layout file

Start the editor in design mode.

You will get a warning message. Click No.1

Click New layout.2

1

2

A new untitled layout will be created.

Choose the Design tab and click Setup Product....3 4

3

4
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From the 1 Product: list choose the product name you just setup in
the products.xml file. In this example it is named new created2
product.

Click Set.3

1

3

2
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From the Edit Chunk list choose the chunk you want to setup.1
layout file

Now type in all neccessary values .2A layout file is always ‚con-
nected‘ to a template file and

If you have more than one chunk choose the other chunk from the Editneeds to have the same page
Chunk list and type in all neccessary values.dimensions etc.

1

2

PageSize
The bleed has to be added to the
page size.

Create a new photobook
When updating a existing layout
or template file this has to be
switched off.

Please note that - different from common graphics art usage - the page
bleed is included in the page size, i.e. to have e.g. an A4 trimmed page size
with 3mm bleed around, you need to specify a page size of 216x303mm!
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Switch to the Options tab.1

Now you can set the default font /size used for all Rich Text fields in a2
product. The font selected here will also be used when displaying the text
Double-click to edit text.

default font
When done click OK.3The default font should be a

default windows fonts and not a
custom font. Otherwise the
consumer will not be able to use
that font without installing it on
the system.

1

2

3
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Now you can start to design your layout file.

Place text boxes and image placeholders; place graphic elements on the
appropriate page. Add/remove pages.

image placeholders
Consumer digital photo cameras
save the image with a 3:4 (or
4:3) ratio unlike the traditionell
photo cameras with a 2:3 (or
3:2) ratio.

When the design is done you need to save this layout file.

In the top menu go to File and then Save as....

Type the name you already setup in your products.xml file and1
click Save.2

1 2
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Setup a new template file

Start the editor in design mode.

You will get a warning message. Click No. 1
template file

Click New layout.2With a template you can give
the consumer the opportunity to
have predefined templates
hooked up to a certain product
(layout).

2

1

A new untitled template will be created.

Choose the Design tab and click Setup Product....3 4

3

4
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From the 1 Product: list choose the product name you just setup in
the products.xml file. In this example it is named new created2
product.

Click Set.3

1

2
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From the Edit Chunk list choose the chunk you want to setup.1
layout file

Now type in all neccessary values .2A layout file is always ‚con-
nected‘ to a template file and If you have more than one chunk choose the other chunk from the Editneeds to have the same page

Chunk list and type in all neccessary values.dimensions etc.

1

2
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Switch to the Options tab.1

default font Now you can set the default font/size used for all Rich Text fields in a2
product. The font selected here will also be used when displaying the textThe default font should be a

default windows fonts and not a Double-click to edit text.
custom font. Otherwise the
consumer will not be able to use When done click OK.3that font without installing it on
the system.

1

2

3
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image placeholders
Now you can start to design your template file.

Consumer digital photo cameras
save the image with a 3:4 (or Place text boxes and image placeholders; place graphic elements on the4:3) ratio unlike the traditionell

appropriate page. Add/remove pages.photo cameras with a 2:3 (or
3:2) ratio.

When the design is done you need to save this template file.

In the top menu go to File and then Save as....

Type the name you already setup in your products.xml file and1
click Save.2

2
1



1STEIN Corp. - 3P Desktop Publisher - Documentation Page 43

Explanation of Design Tab

Setup Product...1

Product setup dialog.1

2 2 (Temporarily disable restric-
tions)

While this option is activated all design restric-
tions from the »products.xml« file will be dis-

3 abled.

It may be necessary to activate during design.
4

Chunk3

Associate a specific chunk to selected page
5 (page dependent).

DoubleSided4
6 Choose wheter the page is double or single

sided.
7 Page Caption left5

Define a page caption for the
left page.

Page Caption right6

Define a page caption for the
right page.

Bleeds7

Change bleed settings and fold width for a
particular page (page dependent). This is al-
ready set in product layout.

No insert before8

Define wether it is allowed to insert a page
before the selected page or not (page depen-
dent).

No insert after9

Define wheter it is allowed to insert a page after
the selected page or not  (page dependent).

Locked10

Define wheter a page is locked or not. When a
page is locked the consumer can‘t move objects
which are already placed on this page and can‘t
add additional pictures (only into predefined
boxes).
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Background fixed (Layout only)11

A designer is able to fix a background, i.e. the
consumer will not be able to change the back-
ground. For technical reasons this ability is
limited to layout files. Fixed backgrounds in
template files cannot be transferred correctly to
a layout. For a workaround in templates it is
recommended to use a standard image frame,
fixed as “background”.

This has the additional benefit on being able to
use High-Res Replacement.

Shape Properties12

Top/left position, height /width and rotation of a
selected object (in mm).

Don‘t print13

Define whether a selected object will print or
not.

This selection will not be validated.

Background14

Define if a selected object should always be in
the background.

This should be used thoughtfully.

Foreground1511

Define if a selected object should always be in
the foreground.

12
This should be used thoughtfully.

Locked16

Lock text boxes or image placeholders. in place
so that a consumer cannot move or size it.

13
High-Res Substitution1714

3P is capable to have low-resolution images15
in the product layout, which are then replaced16
by high-resolution representations on the server.17
This feature is intended to allow for small-foot-
print downloadable products, still allowing for
high quality printouts.

This feature is explained separately below.
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Lock font18

It is possible to lock the font for the text box.

Lock font size19

It is possible to lock the font size for the text
box.

Fix Shape20

Choose this to fix the position of a selected
object.

If you fix a object you can not select it anymore.

This selection will not be validated.

Unfix all Shapes21

Unfix all objects.

If you want to select a fixed object you need to
unfix all objects.

Validate22

This will validate the product.

18

19

20

21

22
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Highres Replacements

This feature is intended for design-mode only, i.e. only the product design-
er (NOT the consumer) can specify that for a certain image there is a
high-resolution image on the server.

The feature is a page-level feature, i.e. as soon as a page contains a
marked “low-res” image, the whole page (or if applicable the double-
page) will be marked as a page to be rendered on the server. In conse-
quence all images added by the consumer will be uploaded in full resolu-
tion and the page(s) will be rendered on the server.

So the benefit of having a compact download (client) might be at the
expense of having a larger uploads and also require additional processing
time on the server. Therefore it is recommended to use the feature only if
absolutely required.

Pages that do not contain any images that should be replaced by a high-
res representation will be rendered on the consumer PC and uploaded in a
compact flattened format.

Usage:

In design-mode the editor has a checkbox “High-Res Substitution” 1
which can be selected for any image.

21

As soon as this box is checked the image – and in consequence the spread
– will be marked to be replaced with high-res images on the server, so the
page will be uploaded as .dtp file and be rendered on the server.

On the server-side the high-res representation of the image has to be
available in a configurable directory with exactly the same file name as the
low-res representation.

The server-side image directory is configurable in
C:/Tomcat5.028/webapps/3P_BackOffice2/WEB-INF/
classes/opi.properties

The preconfigured default is

C:/data2/p4m_3P/opirenderer/images

Since there is no way to provide low-res images to a consumer and to
make sure that the consumer places those images in the correct frames,
High-Res Replacement can only be used with fixed frames. This restriction
is not implemented on the user interface for convenience reasons, there-
fore the designer has to make sure that all High-Res Replacement Frames
are appropriately fixed.
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High-Res Replacement frames nevertheless can be used in Templates.
Together with the new ability to have content in a template, this can be a
powerful feature, e.g. for calendars or predesigned books.

Limitations:

• For technical reasons high-res replaced images are always “fit to
frame” when replaced on the server. This means that any cropping
areas, frames etc are lost when the image is replaced with its high-res
replacement on the server side.

• Since the only link between the server and the editor with respect to
high-res/low-res images is the file name

• There is no checking if the printed size or aspect ratio of the high res is
the same as the low res, i.e. if the low res is 200x200 pixels square
and placed to a square frame and the high res is 2000x1000 pixels,
the high-res will be distorted into a square frame

• The image is always “fit” in the frame, i.e. any cropping is lost, as well
as e.g. frames

• There is no checking that the high-res image has the same content
than the low-res image. If the high-res shows a camel and the low res
(with the same file name) shows a tiger, the consumer will see a tiger
and get a camel!

Max Res2

When using highres replacements the designer is able to specify a maxi-
mum resolution for the images embedded in the dtp file using the “Max.
Res” entry field.  This way he can actually use the highres file to create the
template, and the Editor will automatically create and embed a low-res
version.  In theory the max. Resolution can be set to anything, but high
values may basically make the concept of highres replacements obsolete.

Due to a technical limitation this feature will eliminate transparencies, e.g.
in GIF files, so when using transparent images with highres replacements
you should create the lowres representation of your own and set the value
of Max. Res higher than the resolution of this file. This way the feature will
not touch the image and transparencies are retained.


